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Concept
DataStudio
ScienceWorkshop (Mac)
ScienceWorkshop (Win)

Biochemistry
GS08 Catalase. ActivityDS
G08 Catalase Activity
G08_CATA.SWS

Equipment Needed
Qty
Chemicals and Consumables
Qty

Pressure Sensor – Abs. (CI-6532)
1
Chicken liver extract
10 mL

Balance (SE-8723) 
1
Glycerin
1 mL

Connector (640-030)
1
Hydrogen peroxide, 3% 
100 mL

Flask, 250 mL  
1
Sodium fluoride, solid 
0.1 g

Graduated cylinder, 100 mL
1
Sodium carbonate, solid
1 g

Magnetic stirrer & spin bar
1
Water, distilled
500 mL

Stopper, one hole, for flask
1



Test tube
1



Tubing (w/ sensor)
1



Protective gear
PS



What Do You Think

[image: image1.wmf]What are some factors that can influence the rate of enzyme activity in an organism?

Take time to answer the ‘What Do You Think?’ question(s) in the Lab Report section.

Background

[image: image11..pict]In this activity you will study some of the factors that influence the rate of reaction of an enzyme activity. The enzyme is called catalase . It changes poisonous hydrogen peroxide to water and oxygen. 

When cells convert food into energy (in the process called cellular respiration), one of the by-products is hydrogen peroxide. Hydrogen peroxide is a very active chemical. It can poison other chemicals in a cell causing the cell to die. Catalase is an enzyme that can break down the poisonous hydrogen peroxide.

Catalase reduces the peroxide part of the hydrogen peroxide molecule into water and oxygen by the following reaction:

[image: image24..pict]
Since catalase is not used up in the chemical reaction, the same enzyme can start another reaction. This activity will measure the rate at which the catalase enzyme can reduce the toxic hydrogen peroxide to the harmless products of water and oxygen.

Since the breakdown of hydrogen peroxide produces oxygen gas, what is a way to measure the rate of the production of that gas?

Take time to write an answer to this question in the Lab Report section.

SAFETY REMINDERS
· Wear protective gear while handling chemicals.

· Follow directions for using the equipment.

· Dispose of all chemicals and solutions properly.
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For You To Do

Use the Pressure Sensor to measure the change in gas pressure inside a flask containing hydrogen peroxide and a source of catalase enzyme. The first trial will show how pure crude catalase reacts with the hydrogen peroxide solution. The other three trials will show what happens if other chemicals are added to change the hydrogen peroxide or dilute the catalase. Use DataStudio or ScienceWorkshop to record and analyze the data.
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PART I: Computer Setup
1.
Connect the ScienceWorkshop interface to the computer, turn on the interface, and turn on the computer.

2.
Connect the Pressure Sensor DIN plug into Analog Channel A on the interface. 

3.
Open the file titled as shown;

DataStudio
ScienceWorkshop (Mac)
ScienceWorkshop (Win)

GS08 Catalase. ActivityDS
G08 Catalase Activity
G08_CATA.SWS

•
The DataStudio file has a Workbook display. Read the instructions in the Workbook. The file has a Graph of Pressure versus Time and a Digits display of Pressure.

•
The ScienceWorkshop document opens with a Graph display of Pressure (kPa) versus Time (s).

•
Data recording is set for 1 measurement per second with a ‘Stop’ condition at 150 s.

PART II: Sensor Calibration and Equipment Setup
Sensor Calibration

· You do not need to calibrate the Pressure Sensor for this activity. 

Set Up the Equipment

[image: image13..pict]1.
Put a drop of glycerin on the barb end of the quick-release connector and insert the barb into one end of the plastic tubing.

[image: image14..pict]2.
Put a drop of glycerin on the smaller diameter end of the connector that will go into the stopper. Insert the small diameter end into the plastic tubing. 


3.
Put a drop of glycerin on the larger diameter end of the connector that will go into the stopper, and insert the end into the stopper. 

4.
Carefully put a spin bar into the flask and place the flask on the magnetic stirrer.

[image: image15..pict]PART III: Data Recording
· There are four parts to the data recording.

Part
Catalase
Sodium

Fluoride
Sodium

Carbonate
Hydrogen

Peroxide

A
2 mL crude catalase
none
none
15 mL diluted to 100 mL

B
2 mL crude catalase
0.1 g
none
15 mL diluted to 100 mL

C
2 mL crude catalase
none
1.0 g
15 mL diluted to 100 mL

D
1 mL crude catalase diluted with 1 mL of distilled water
none
none
15 mL diluted to 100 mL

[image: image16..pict]PART IIIA: Catalase + Hydrogen Peroxide
Prepare the Mixture

1.
Pour 15 mL of 3% hydrogen peroxide in a 100 mL graduated cylinder. Fill the cylinder to the 100-mL mark with 85 mL of distilled water.

2.
Transfer the diluted peroxide solution to the flask. 

3.
Turn on the stirrer.

4.
Add 2 mL of catalase extract to the dilute peroxide solution in the flask. 

[image: image17..pict]5.
Put the one-hole stopper into the flask.

[image: image18..pict]6.
Align the quick-release connector on the end of the plastic tubing with the connector on the pressure port of the Pressure Sensor. Push the connector onto the port, and then turn the connector clockwise until it clicks (about one-eighth turn).

Record the Data

7.
Start recording data. (Hint: Click ‘Start’ in DataStudio or ‘REC’ in ScienceWorkshop.)

•
Data recording will stop automatically at 150 seconds.

Clean Up

8.
Disconnect the tubing from the Pressure Sensor. Remove the stopper from the flask.

9.
Dispose of the peroxide mixture as directed and clean the flask thoroughly.

Part IIIB: Catalase + Hydrogen Peroxide + Sodium Fluroide
[image: image19..pict]Make a prediction: 

What effect do you think adding an inhibitor to the hydrogen peroxide will have on the enzymes’s ability to catalyze the breakdown of the peroxide? Put your prediction and a brief explanation in the Lab Report.

Prepare the mixture

1.
Repeat the data recording procedure. Put 100 mL of dilute peroxide solution in the flask. Add the spin bar. 

2.
Add 0.1 g of sodium fluoride to the peroxide solution. Add 2 mL of catalase extract to the flask and stopper the flask.

3.
Re-connect the tubing to the Pressure Sensor.

Record the data

4.
Start recording data. (Data recording will stop automatically at 150 seconds.)

Clean Up

5.
Disconnect the tubing from the Pressure Sensor. Remove the stopper from the flask.

6.
Dispose of the peroxide mixture as directed and clean the flask thoroughly.

Part IIIC: Catalase + Hydrogen Peroxide + Sodium Carbonate
Make a prediction: 

[image: image20.png]


What effect do you think adding a base to the hydrogen peroxide will have on the enzymes’s ability to catalyze the breakdown of the peroxide? Put your prediction and a brief explanation in the Lab Report.

Prepare the mixture

1.
Repeat the data recording procedure. Put 100 mL of dilute peroxide solution in the flask. Add the spin bar. 

2.
Add 1.0 g of sodium carbonate to the peroxide before you add the catalase. Add 2 mL of catalase extract to the flask and stopper the flask.

3.
Re-connect the tubing to the Pressure Sensor.

Record the data

4.
Start recording data. (Data recording will stop automatically at 150 seconds.)

Clean Up

5.
Disconnect the tubing from the Pressure Sensor. Remove the stopper from the flask.

6.
Dispose of the peroxide mixture as directed and clean the flask thoroughly.

Part IIID: Diluted Catalase + Hydrogen Peroxide
Make a prediction: 
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What effect do you think diluting the catalase will have on the enzymes’s ability to catalyze the breakdown of the peroxide? Put your prediction and a brief explanation in the Lab Report.

Prepare the mixture

1.
Repeat the data recording procedure. Put 100 mL of dilute peroxide solution in the flask. Add the spin bar. 

2.
Put 1 mL of crude catalase extract into the test tube. Add 1 mL of distilled water to dilute the catalase. Add the diluted catalase extract to the flask and stopper the flask.

3.
Re-connect the tubing to the Pressure Sensor.

Record the data

4.
Start recording data. (Data recording will stop automatically at 150 seconds.)

Clean Up

5.
Disconnect the tubing from the Pressure Sensor. Remove the stopper from the flask.

6.
Dispose of the peroxide mixture as directed and clean the flask thoroughly.

ENDING THE ACTIVITY (See the section after Questions)

Analyzing the Data
1.
Set up the Graph display to show all your data

•
Hint: DataStudio automatically shows all the runs of data. In ScienceWorkshop, do the following to put two runs of data in the top plot and two runs of data in the bottom plot. 

•
Click the ‘Add Plot Menu’ button ([image: image5.png]


) to add a second plot to the Graph window. Select Analog Channel A, Pressure from the Add Plot Menu.
[image: image22.png]



•
Click the ‘Add Plot Menu’ button again to add a third plot to the Graph window. Select Analog Channel A, Pressure from the Add Plot Menu.

[image: image23.png]


•
Click the ‘DATA Menu’ button ([image: image6.png]


) in the top plot. Select Run #1 from the DATA Menu. Repeat to select Run #2 from the DATA menu.


•
Click the ‘DATA Menu’ button in the middle plot. Select No Data first. 

•
Use the Data Menu in the second plot to select Run #3 and then Run #4. 

2.
Use the built-in statistics for the Graph display to find the minimum pressure and the maximum pressure for each run of data.

•
Hint: In DataStudio, click the ‘Statistics Menu’ button ([image: image7.png]


). The default statistics are ‘Minimum’ and ‘Maximum’. The values appear in the legend in the display area.

In ScienceWorkshop, click the ‘Statistics’ button ([image: image8.png]


) to open the statistics area. Click the ‘Statistics Menu’ button ([image: image9.png]


). Select ‘Maximum’ from the menu. Repeat and select ‘Minimum’ from the menu.

3.
Record the minimum pressure as the starting pressure. Record the maximum pressure as the ending pressure. 

4.
Calculate the difference in pressure.

5.
Calculate the enzyme activity. Divide the difference in pressure by the amount of time (in minutes).


[image: image10.wmf]
Record your results in the Lab Report section.

Lab Report - Activity GS08: Catalase Activity – Enzyme Action

What Do You Think

What are some factors that can influence the rate of enzyme activity in an organism?

Since the breakdown of hydrogen peroxide produces oxygen gas, what is a way to measure the rate of the production of that gas?

Predictions

Part IIIB: Catalase + Hydrogen Peroxide + Sodium Fluoride

What effect do you think adding an inhibitor to the hydrogen peroxide will have on the enzymes’s ability to catalyze the breakdown of the peroxide?

Part IIIC: Catalase + Hydrogen Peroxide + Sodium Carbonate

What effect do you think adding a base to the hydrogen peroxide will have on the enzymes’s ability to catalyze the breakdown of the peroxide?

Part IIID: Diluted Catalase + Hydrogen

What effect do you think diluting the catalase will have on the enzymes’s ability to catalyze the breakdown of the peroxide?

Data Table

Item
Part IIIA
Part IIIB 

Sodium Fluoride
Part IIIC 

Sodium Carbonate
Part IIID

Diluted

Starting Pressure
kPa
kPa
kPa
kPa

Ending Pressure
kPa
kPa
kPa
kPa

Pressure Difference 
kPa
kPa
kPa
kPa

Activity (kPa/min)





Questions

1.
What happens to the pressure inside the flask when pure crude catalase is added to diluted hydrogen peroxide?

2.
What is the effect of adding sodium fluoride to the solution of hyrodgen peroxide? Is there as much reaction, more reaction, or less reaction than without the sodium fluoride?

3.
What is the effect of adding sodium carbonate to raise the pH of the solution of hydrogen peroxide? Is there as much reaction, more reaction, or less reaction than without the sodium carbonate?

4.
What is the effect of diluting the catalase before you added it to the solution of hydrogen peroxide? Is there as much reaction, more reaction, or less reaction than when you used pure crude catalase?

---------------------------

Ending the Activity

Equipment Clean Up

•
Check with your instructor about cleaning and putting away the equipment for this activity. 

•
Check with your instructor about disposing of the chemicals that you used in the activity. DO NOT pour the chemicals down the sink unless you are told it is all right to do so.

Computer Shutdown

When you have finished, you have several options. 

1.
You can select ‘Quit’ from the ‘File’ menu to end the activity. 

2.
You can select ‘Save’ or ‘Save As…’ from the File menu to save your data for this activity. the changes you’ve made to the document. 

•
The original document is “locked”, so you should give your document a new filename.

3.
If you wish to go on to the next activity, select ‘Open…’ from the ‘File’ menu, and find the document for the next activity. 
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